
Permanent Change of Station Travel Orders 

Overview 

  
Introduction This guide provides the procedures for completing Permanent Change Of 

Station (PCS) Travel Orders.  This guide is for Permanent Duty (PERMDU), 
Temporary Duty (TEMDU), and inter/intra district transfers of active duty 
members. 

  
Reference The following references provide additional information about PCS 

entitlements and regulations. 
 

• Personnel Manual, COMDTINST M1000.6 (series), Chap 4 
• Joint Federal Travel Regulations, Volume 1 
• Personnel and Pay Procedures Manual, PSCINST Ml000.2 

(series), Chap 2) 
• Direct Access Online Help: PCS Departing Endorsement 

(http://www.uscg.mil/hq/psc/ps/pcs/pcs_departing_endorsement.htm) 
• Direct Access Online Help: PCS Reporting Endorsement 

(http://www.uscg.mil/hq/psc/ps/pcs/pcs_reporting_endorsement_on_orders.htm) 

   
Airport 
Terminal 

To access Travel Orders they must first be issued by the Assignment Officer 
and appear on the Airport Terminal.  The Airport Terminal provides 
commands with the ability to view and process arrivals and departures of 
personnel.  Please contact the member’s Assignment Officer, CGPC (epm) 
for active duty enlisted members (including members on EAD), CGPC (opm) 
for active duty officers (including those on EAD) or the ISC (fot/pf) for 
reservists if orders need to be issued. 

   
TONO 
Accounting 
Data 

The Travel Order Number and Accounting Data will already be populated and 
grayed out.  No data entry/changes will be permitted when the Orders 
Accounting Information is generated off the Airport Terminal. 

     
Assignment 
Officer 
Remarks 

Standard Remarks/Orders Notes entered by the CGPC (opm/epm) or the ISC 
(pf/fot) Assignment Officer shall not be modified or deleted by other users at 
the command or SPO. Other users, desiring to add remarks to an order, must 

access the remarks section by clicking  followed by the 
 button. 

 

http://www.uscg.mil/directives/cim/1000-1999/CIM_1000_6A.pdf
http://perdiem.hqda.pentagon.mil/perdiem/trvlregs.html
http://www.uscg.mil/hq/psc/3pm.asp
http://www.uscg.mil/hq/psc/3pm.asp
http://www.uscg.mil/hq/psc/ps/pcs/pcs_departing_endorsement.htm
http://www.uscg.mil/hq/psc/ps/pcs/pcs_reporting_endorsement_on_orders.htm
http://www.uscg.mil/hq/psc/ps/assignment_system/airport_terminal/airportterminal.htm
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Topics The following topics are covered in this section. 
 

Topic See Page 
Completing PCS Travel Orders 3 
Approving PCS Travel Orders 11 
Interoffice Transfers -- Fleet-Ups 12 
Extensions 14 
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Completing PCS Travel Orders  

  
Introduction This section provides the procedures for completing and approving a Travel 

Order. Upon approval, a paper copy can be printed for the member to 
facilitate PCS needs such as shipment of Personal Property, Assignment or 
Termination of Housing.  

  
Procedure Start PeopleSoft, sign-in and follow these steps to access PCS Travel Orders 
 

Step Action 
1 Orders can be access by the menu paths; 

1. From your Worklist (if your supervisor routed them to you from the Airport Terminal). 
By selecting menu items in the following order: 
 
2. Home > Administer Workforce > Track Global Assignments (GBL) > Use > PCS Orders  
3. Home > Develop Workforce > Plan Careers > Inquire > Arrivals and Departures 

 
4. The Airport Terminal menu path of - Home > Self Service > Self Service for Commands > 

Use > Command Information - provides commands with the ability to view and process 
arrivals and departures of personnel.  The Airport Terminal lists orders for all personnel.  
Detailed instructions for the Airport Terminal can be obtained from the PSC website at:  
http://www.uscg.mil/hq/psc/ps/assignment_system/airport_terminal/airportterminal.htm 

2 At the Departures listing screen.  Click the Process Orders tab. .. 
 

 
3 Click the Route/Work button of the Employee ID for the Orders you wish to complete. 

This button can also be used for Supervisors routing work to personnel within 
the SPO 

 
Continued on next page 
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Completing PCS Travel Orders, Continued 

Procedure (cont’d)  
 
Step Acton 
NOTE Status of Orders: 

Status Meaning 
Apvd Mtual An approved mutual exchange of station. 
Apvd Std An approved set of regular orders. 
Apvd Unlat  An approved order for a unilateral. 
Cancel Canceled orders 
Enroute Enroute (based on estimated departure date) 
Finished The member has departed the old unit and has reported into the new unit 

(JUMPS 8C's have processed). 
Proposed Orders in a proposed status 
Ready Indicates the orders have been worked (member specific changes have 

been made to the orders) and the orders are now 'Ready' for the member 
to travel.  
Note: Orders for extensions and fleet ups will not change to a ready 
status because travel entitlements are not applicable. 

X Ord/TONO Cancel the orders but keep the TONO active.  
4 If you began in the Airport Terminal, a new window will open.  The path in the window 

is now the PCS Orders menu. 
5 Click in the Authorizing Official (Name, Rate/Rank) field.  Enter the Name and 

Rate/Rank of the Official signing the Orders:   

 
6 Nature of Duty Section:  For Assignment Officer issued orders this field will already be set.  For 

a Nature of Duty listing, click on the drop down button. 

 
7 Scroll down to the Authorized Delay Enroute Section.   Click in the Begin Date field  

and enter a date in MMDDYYYY format. OR Click the Choose a Date to select a Begin Date.  
This is the leave date the member is planning on departing his current unit, normally 
taken from the \members PCS Departing Worksheet.  (The actual dates will be entered 
upon departing member and reporting member.)   
To toggle through months and years click  

8 Click in the End Date field  and enter a date MMDDYYYY format, OR Click the 
Choose a date to select a End Date.  Click the Choose a date button  to select a Date.   

 
Note: Steps 7-9 must be completed for each type of delay, such as Authorized Travel Time, and 

Authorized Proceed Time. Add a Delay Period by clicking on the  button. 
 

Continued on next page 
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Completing PCS Travel Orders, Continued 

  
Procedure (continued) 
Note: Steps 7-9 must be completed for each type of delay, such as Authorized Travel Time, and 

Authorized Proceed Time. Add a Delay Period by clicking on the  button. 
Step Action 

9 Click the Delay Enroute dropdown button to view and select from the list.    Select the type of 
delay authorized for the dates entered. 

Delay Use 
Travel Time If member is authorized travel time, enter the inclusive dates 

(in steps 7 and 8) for the number of days the member is 
authorized  

Proceed Time If member is authorized proceed time, enter the inclusive dates 
(in steps 7 and 8) for the number of days the member is 
authorized. 

Leave INCONUS If member is authorized leave INCONUS, enter the inclusive 
dates (in steps 7 and 8) for the number of days the member is 
authorized. 

Leave OCONUS If member is authorized leave OUTCONUS, enter the inclusive 
dates (in steps 7 and 8) for the number of days the member is 
authorized. 

Compensatory Absence If member is authorized compensatory absence, enter the 
inclusive dates (in steps 7 and 8) for the number of days the 
member is authorized. 

Non-Chargeable Absence If member is authorized non-chargeable absence, enter the 
inclusive dates (in steps 7 and 8) for the number of days the 
member is authorized. 

Dateline Adjustment If the member crossed the international dateline, enter the 
inclusive date (in steps 7 and 8), normally 1 day. For members 
traveling West to East use the same date as the reporting date. 
For members traveling East to West, use the date the member 
departed their PDS.  The United States is in the West.  If 
crossing was West to East, the total of all delay entries 
including DA should equal authorized delay total.  If crossing 
was East to West, add all delay entries other than DA, then 
subtract 01.  The balance must equal authorized delay total.  

Example PCS Delay With Dateline Adjustment (West to East): 

  
 

Continued on next page 
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Completing PCS Travel Orders, Continued 

  
Procedure (continued) 
 
Step Action 
10 

Scroll down to the  section and Click the Duty tab. .   
 

Field Description 
Nature of Duty Make a selection from the dropdown menu. 

Per Diem This button is not Active (nothing happens when clicked) 
for PCS Orders. Enter Per Diem entitlement in Notes 
(remarks)  

11 Select primary mode(s) of travel.  When an item(s) is selected, an item in Primary Mode of 
Transportation must also be selected. 

. 

 Commercial Carrier (own expense subject to reimbursement) is the default setting.  
Deselect if not the primary mode of travel 

 

The sections titled Remain Over Night (RON) and Medical Travel apply to TAD travel 
authorizations.. 

12 If Other Authorized Expenses are authorized (normally this won’t apply to PCS Orders), Select 
the Magnifying glass in the Search Dialog Box .  Enter the Misc Expense code (if already 
known), or a description to lookup a specific authorization. 

Click on the  to view a listing of available Authorized Expenses. 
13 

To add additional authorized expenses, click on the   button.  To remove expenses 
click on the  button.  When selecting the delete button, the following window will 
display, click OK. 

 
 

Continued on next page 
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Completing PCS Travel Orders, Continued 

  
Procedure (continued) 
 
Step Action 
14 

Scroll to the bottom and click on the Orders Notes Button  
15 Select Magnifying glass to obtain Search Dialog Box.  To obtain PCS Order notes, select 

Lookup or enter PCS in the Description box and select Lookup.  Orders generated by CGPC will 
have pre-filled notes.  These notes should not be changed without CGPC approval.  To add 

additional notes click on the  button and click on the OK button when complete. 

. 
Note: The order note “PCS” contains standard remarks, applicable to all PCS orders, which may 
be edited as necessary by the SPO. 

 
Reminder:  Standard Remarks/Orders Notes entered by the CGPC (opm/epm) Assignment Officer 
shall not be modified or deleted by other users. Always add a new order note entry to add remarks 
to orders. These notes should not be deleted or modified without CGPC approval. 

16 Scroll down to the bottom of the page and click the  button. 
17 The field “Dependents Accompanying Member will appear blank.   

 

 
 

Continued on next page 
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Completing PCS Travel Orders, Continued 

  
Procedure (continued) 
 
Step Action 
18 Click the Member's Dependents button.  . .  You will see a listing of 

Dependents for the member.  ” 

 

Dependents must be already in direct access as dependents to appear on this 
screen.  Dependents not appearing on this screen must first be added in Direct 
Access.  BAH eligible dependents are defined in Chapter 3-F of the Coast Guard Pay 
Manual, COMDTINST M7220.29(series).

19 To Select members authorized to travel on the Travel Orders, click the Selected 
option. 

.  Once selected, a check mark will appear next to the Dependents Name. . 
Click the Ok button. 

 
20 The Dependent selected now appears on the Dependents auth to travel screen as 

below.  Click the Ok button. 
. 

 
 

Continued on next page 
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Completing PCS Travel Orders, Continued 

  
Procedure (continued) 
 
Step Action 
21 Click the Save button. 

 
22 Scroll down to and Click the Route For Approval button. 

. 
23 Only a CGHRSUP (SPO Supervisor) can approve these orders.  Enter the Employee ID 

of the Supervisor who will be approving these orders in the Route to field. Enter  

 You can also click on the  button to look up the Approvers Employee ID 
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Approving PCS Travel Orders 

  
Introduction This section provides the procedure for approving the PCS Travel Orders.  

Approval Authority is designated to SPO Supervisors with the Direct Access 
Role of HRSUP.  Command Users must route Travel Orders through their 
Servicing Personnel Office for Approval. 

 
Procedure Follow the steps in one of the menu paths below to access the Worklist. 

 
Step Action 
Menu 
Path 

The Approver must access the orders through their Worklist, using the menu paths 
 
Home > Self Service > Employee > View > View My Worklist  
Home > Self Service > Manager > View > View My Worklist 
Home > People Tools > Worklist > Use > Worklist 

1 Locate the PCS Orders to work in the “Link” column, then click on the Employee. 

 
2 

Click on the Travel Orders Tab .  Verify all PCS information is correct.  Then 

click on the  button located at the bottom of the screen. 
 

Continued on next page 
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Approving PCS Travel Orders, Continued 

  
Procedure (cont’d)  
 

Step Action 
Once in the PCS Routing & Travel Approval screen, Supervisors must decide which action 
from the Approval Status button to take.  The Selections are: 

3 

 
• Approve – select to approve 
• Denied – Select to deny (disapprove) the Orders.  If desired, a text box is available to 

advise why the orders are being denied. 
• Pending  - This used when orders need further information., You may return and 

complete the transaction at a later date. – 
 

 
 

 If the Approver selects Denied, or Pending, the orders can be rerouted to a 
specific user by entering the Employee Id in the “Route to: block.   When an 
employee id is entered in the route to block the transaction will appear on their 
Worklist. 

3 
Click on  

 
The PCS Departing Endorsement must be completed next. The endorsement cannot be 
completed more than 14 days before the member actually departs. Please read the PCS Departing 
Endorsement instructions in the Direct-Access Online Manual 
(http://www.uscg.mil/hq/psc/ps/pcs/pcs_departing_endorsement.htm) for more information. 
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Interoffice Transfers -- Fleet-Ups 

  
Introduction An Interoffice Transfer occurs when orders are issued by an 

Assignment Officer to transfer a member within the same unit.  

  
Locating 
Orders in the 
Airport 
Terminal 

The DA orders will list the action/reason code of "FLT" for Fleet-Ups. 
These types of orders can easily be located on the Unit's or SPO's Airport 
Terminal by setting the Advance Search Options. An example search for 
"Fleet-Ups" is shown below: 

 

  
SPO Action When Fleet-Up orders are issued the SPO must:  

 
1. Approve and save the orders.  
2. Complete the Actual Depart date field Depart/Report Mbr tab.  
3. Approve and save the Departing Endorsement. 

 
The system will automatically fill the Actual Reporting Date, using the same 
date entered in the Actual Depart date field, as shown in the screen shot 
below: 

 

 
 

Continued on next page 

12 



Permanent Change of Station Travel Orders 

Interoffice Transfers -- Fleet-Ups, Continued 

  
Output These steps are required to process the position change and to create the 

JUMPS departing and a reporting Endorsement on Orders transactions (8Cs), 
which will update the member's cost center.  The position change will also 
reset the member's user access roles in Direct-Access to self-service only. A 
new user access form will need to be submitted to restore access. 
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Extensions 

  
Introduction This section provides the procedure for processing an order for an extension. 

  
Discussion CGPC (epm/opm) Assignment Officers issue orders when they approve 

extensions. The extension orders will appear on the Airport Terminal and can 
be located by using "Transfer" and "EXT" in the Advance Search Options 
(as shown below). 

 

 

  
Procedure Unlike PCS orders or Interoffice transfers and Fleet-Ups, SPOs do not need to 

complete the Depart/Report member tab if the order reason code is "EXT" (all 
the fields on this tab are "grayed out" when the order reason code is "EXT"). 
However, you do need to approve the orders and save them to update the 
Status to “Finished”. Be sure to check the Orders Notes (aka "Remarks") to 
see if the AO specified any obligated service or other requirements for the 
extension before you approve the orders. 
 
Note: Standard Remarks/Orders Notes entered by the CGPC (opm/epm) or 
the ISC (pf/fot) shall not be modified or deleted by other users at the 
command or SPO. 

   
Rotation Date The depart and report dates on extension orders do not reflect the extension 

begin and end dates, they are populated with default values because 
extensions use the PCS orders component. If the dates only span a day or a 
month, it doesn't mean that the extension is only for that period Go to Home > 
Develop Workforce > Plan Careers > Use > CG Member Info to view the 
member's new rotation date. 
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